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AgendaAgenda

� Basic Movements

� Secret Mission Solution

� Loop, Sensors, Wait, Switches, and the 
LCD Display

� My Blocks� My Blocks

� Variables

� Extra Tips



Before we begin…Before we begin…

� NXT-G’s default setting is for B and C to 
be the drive motors, and A to be the extra

� For the sake of this tutorial: 
◦ motor A is the left◦ motor A is the left

◦ motor C is the right

◦ motor B is for whatever extra movements are 
needed



Creating a ProgramCreating a Program

� Start the NXT-G program

� Use meaningful names!!!

� Upon clicking [Go >>]� Upon clicking [Go >>]

a programming palette will

appear.



Lv. 0: Go Forward for 2 SecondsLv. 0: Go Forward for 2 Seconds

� Click on the Move button

� Drag it to the canvas



Lv. 0: Go Forward for 2 SecondsLv. 0: Go Forward for 2 Seconds

� Change settings (parameters) for the 
block:
◦ Port

◦ Direction

◦ Steering◦ Steering

◦ Power

◦ Duration

◦ Next Action



Let’s test it!!!Let’s test it!!!

� Connect the NXT to the laptop (if this is the 
first time, then a “Found New Hardware” 
message will appear)

� Click on the ‘Download’ button

� It’s recommended to always unplug � It’s recommended to always unplug 
the cable from the bot before running the 
program

� Navigate through the NXT’s menu:
◦ Turn On > My Files > Software Files

◦ Then select your program and run it!



How to reHow to re--run the programrun the program

� Check the program name on the LCD

� Press the orange button just once again



Lv. 1: Go Forward and Return Lv. 1: Go Forward and Return 

� Preparation: 
◦ Go forward two rotations (instead of selecting 
‘Seconds’ from the drop-down menu)

◦ Reverse the motors to return to the original 
location.location.



Lv. 1: Go Forward and ReturnLv. 1: Go Forward and Return

� Preparation 2:
◦ Go forward 720 degrees, then come back by 
reversing motors

� For those of you that have done the math, � For those of you that have done the math, 
anyone noticing a pattern?

� There are many ways to accomplish the 
same task.



The Embedded Rotation SensorThe Embedded Rotation Sensor

� Each motor has an embedded rotation 
sensor.

� 360 counts per rotation

� The counter can be incremented or 
decrementeddecremented

� The distance traveled for each rotation can 
be calculated:
◦ Circumference = 2 x radius x pi

� Note: the standard wheel is 5.5cm in diameter

◦ Or, if you’re feeling lazy, you can just tell it to move 
forward 1 rotation, and measure the distance



Making TurnsMaking Turns

� Turn Left:
left wheel right wheel

Spin Left:                                   � Spin Left:                                   (point turn)
left wheel right wheel

� Face Left:
left wheel right wheel



Lv. 2: Exact Movement CalculationLv. 2: Exact Movement Calculation

� Moving straight forward a certain distance

� The distance traveled for each rotation can 
be calculated:
◦ Circumference = 2 x radius x pi◦ Circumference = 2 x radius x pi

� Note: the standard wheel is 5.6cm in diameter

◦ So let’s move forward exactly 10cm!
� Distance  /  Circumference  = rotations

10cm     /     17.59cm =  0.57cm



Lv. 2: Exact Movement CalculationLv. 2: Exact Movement Calculation

� Mission:
◦ Move forward 14 inches (done)

◦ Spin exactly 90 degrees (…………)

◦ Move forward 2 inches (done)



Lv. 2: Exact Movement CalculationLv. 2: Exact Movement Calculation

Turning 90 degrees

� When the robot spins, both wheels move in 
opposite directions

� Therefore, the “track” or distance from the � Therefore, the “track” or distance from the 
center of one wheel to the center of the other 
wheel is the diameter of the circle

� If the track of your robot is 17cm
� Circumference = 17cm * pi
� One full turn = 53.38cm

Track or
Diameter



Lv. 2: Exact Movement CalculationLv. 2: Exact Movement Calculation

Turning 90 degrees

� 1 full turn = 53.38cm
� 90 degrees is ¼ of 1 full turn
� 53.38 / 4 = 13.435

Track or
Diameter

� 53.38 / 4 = 13.435

� As we know, the wheels move 17.584 cm for 
each rotation of the motors

� 13.435 / 17.584 = 0.76 rotations to spin 90 deg.



Lv. 2: Exact Movement CalculationLv. 2: Exact Movement Calculation

� Mission:
◦ Move forward 14 inches (done)

◦ Spin exactly 90 degrees (done)

◦ Move forward 2 inches (done)

� Put it all together and try it out!



NXT SensorsNXT Sensors

� Light
� Touch
� Ultrasonic (distance measurement)
� Sound (microphone: decibel level)
� Rotation (Embedded in motor)� Rotation (Embedded in motor)
� Timer (Internal Sensor)
� Received Bluetooth Messages
� NXT Buttons (two grays and the orange)



Viewing Sensor ValuesViewing Sensor Values

� On Your Laptop:
◦ NXT-G offers a Live Update feature that lets 
you see what your robot is seeing, through the 
computer.

◦ When you click on a block that uses the light 
sensor (and the NXT is plugged into the sensor (and the NXT is plugged into the 
computer and turned on), you
can view the light sensor value.



Viewing Sensor ValuesViewing Sensor Values

� On Your NXT:
1. Press the orange button (or gray button to 

move up) to see “My Files”

2. Press right gray triangle button twice to 
select “View” and press orange button

3. Select “Reflected Light” and press orange3. Select “Reflected Light” and press orange

4. Select the right port number and press 
orange

5. Then you will see the light sensor value in %



Light SensorLight Sensor

� Percent Mode:
◦ 5%   = lowest dark

◦ 100% = very brigh

� Reflected Light Mode: shines a red light

� The light can be turned off – detecting � The light can be turned off – detecting 
ambient light (surrounding light)



Light SensorLight Sensor

� Navigate the NXT’s menu:
◦ View > Reflected Light
� On White Area: 55% - 65%

� On black area: 43% - 48%

� If the Live Update value is VERY different 
from the view value, then odds are a from the view value, then odds are a 
calibration was set up and it is skewing 
the results.  Calibrations can be created / 
edited / deleted in the Tools Menu of the 
computer program.



Attaching a Light SensorAttaching a Light Sensor

� Facing Down

� Gap: around 0.5 to 1 inch off the ground

� The default port is port 3, so we’ll use 
that!



Lv. 3: Stop at the Edge!Lv. 3: Stop at the Edge!

� Program:



ProTipProTip: Edge of Table Following: Edge of Table Following

� Line following is just 
bouncing along the edge of 
a line

� What’s to stop you from � What’s to stop you from 
dancing along the edge of 
the table?



Commenting Your CodeCommenting Your Code

� Use the comment tool (                ) to 
note the following information:
◦ Author, date of creation

◦ How to use the program

◦ Descriptions◦ Descriptions

◦ Expected sensor values

◦ Known bugs

◦ Functions to improve upon

◦ etc, etc, etc…



Light Sensor Values Light Sensor Values 
on the on the RoboPowerRoboPower fieldfield

� Be able to detect:
◦ The table (pale brown, varies by location)

◦ The edge (nearly no light reflected back)

◦ The black ‘safety’ zone



How to improve in light detectionHow to improve in light detection

� Use a three way branch

� Use two light sensors

� Use a dynamic threshold (the program 
gets the light value before moving, then 
bases all of it’s decisions off of that value)bases all of it’s decisions off of that value)



Using the Touch SensorUsing the Touch Sensor

� The NXT default for the touch sensor is 
port 1, so we’ll go with that.



Lv. 4: Loop until touchedLv. 4: Loop until touched

� Display seconds until the sensor is pressed



Ultrasonic SensorUltrasonic Sensor

� Uses the same scientific principle as bats.
� The NXT can measure in centimeters or in 
inches
◦ 0 – 255 cm (0 – 100.4 inches)

� Precision: +/- 3cm (1.2 inches)
View the sensor information:� View the sensor information:
◦ View > Ultrasonic cm > select port number

� Battery Glitch!  Don’t go under ½ power!



Ultrasonic SensorUltrasonic Sensor

� Large objects with hard surfaces return 
the best readings.

� Objects made of fabrics or something 
curved (like a paper wrapped pop bottle) 
are difficult to detect
Two or more ultrasonic sensors aiming at � Two or more ultrasonic sensors aiming at 
eachother could interfere with eachother’s
readings!



Lv. 5: Ultrasonic DistanceLv. 5: Ultrasonic Distance



Lv. 5B: Spin until object seenLv. 5B: Spin until object seen

� Note that Ultrasonic sensors emit waves 
in a cone-like shape!!!



Lv. 5C: Locating the TargetLv. 5C: Locating the Target

� Algorithm:
◦ Spin right infinitely until the sensor detects an object
◦ Reset the rotation sensor
◦ Spin right until the object is no longer seen
◦ Get the rotation sensor reading, divide it by two, and 
spin left that many degrees

◦ The robot should now be pointing towards the center ◦ The robot should now be pointing towards the center 
of the object

� Warning: 
◦ This code is not stable and requires some trial and 
error to work correctly.

◦ While I said that it’s not advisable to use, there 
aren’t many other options…



RoboPowerRoboPower: The Game: The Game

� Combines:
◦ Sensor handling

◦ Terrain management

◦ A little bit of AI



Creating VariablesCreating Variables

� In the computer program, go to the Edit 
menu and select “Define Variables”

� Enter the variable                              
name and type.
◦ Text = “hello world!”◦ Text = “hello world!”

◦ Number = 1337

◦ Logic = true / false

� Also called boolean



Editing VariablesEditing Variables

1) Open the ‘Complete’ menu

2) Next to the plus sign, 
select the suitcase block

• 2 modes: • 2 modes: 

• Read

• write



ProTipProTip: : MyBlocksMyBlocks

� Wrap a complex procedure into a single 
block.

� Save what little memory the NXT has and 
avoid redundancy.

� Hide complex details.� Hide complex details.



Creating Creating MyBlocksMyBlocks

� Start with working code

� Highlight blocks to include

� Click the “Create MyBlock” button

� Name the MyBlock

� Build the icon(s)� Build the icon(s)

� MyBlock replaces the selected code

� It is also now available in the ‘custom’ 
menu



Editing the NXT’s MemoryEditing the NXT’s Memory

� A utility called the NXT Window 

will be your best friend for this!

� When the window pops up, click on the 
‘Memory’ tab, select a file type from the 
chart on the left.  This window can also chart on the left.  This window can also 
upload and download files to / from the 
NXT.

� NOTE: No system files are shown!  This 
means that you can delete at random and 
the NXT will still work without a hitch.



Tips:Tips:

� “Out of Memory” problem:
◦ Do not use sound files, or delete the currently 
existing files 

◦ Do not display graphics

◦ Minimize the number of programs on the NXT

◦ Delete Unnecessary programs◦ Delete Unnecessary programs



Tips:Tips:

� Debugging:
◦ Gradually, not all at once.

◦ Beeps help, make the robot beep whenever it 
thinks that it sees a line and your coding gets a 
LOT easier.  Displaying values helps too!

Game Details:� Game Details:
◦ The space between the edge of the table and 
the ‘safety zone’ is unknown, some ‘scanning’ 
with an ultrasonic sensor might be necessary.



Something Cool:Something Cool:
Getting rid of the startup sound!Getting rid of the startup sound!

� If you open the ‘Memory’ window (shown 
three slides ago) and navigate to the 
Sound files, you can delete the startup 
sound.

� Now the NXT will turn on WITHOUT THE � Now the NXT will turn on WITHOUT THE 
MUSIC!!!

� If you want to reload it, it’s one of the 
sound effects available to the sound 
block.  Just make a program that uses 
that sound and it will be saved again, 
even if you delete the program.



Acquiring More PartsAcquiring More Parts

� You can purchase spare parts (and a couple 
recently developed sensors, including a color 
sensor) at    mindstorms.lego.com

� Interested in buying pieces?  Bricklink allows 
people to sell and buy lego bricks, many a 
rare part can be found there, and the prices rare part can be found there, and the prices 
are EXCELLENT!    www.bricklink.com

� Lots of 3rd party companies sell sensors and 
other parts that are available nowhere else!



FREEDOM!!!!!!!FREEDOM!!!!!!!

� Questions?  Comments?  Concerns? 
Restraining orders? (…hope not…)
◦ Feel free to drop me an email for any of the 
above (although any notices for restraining 
orders can be forwarded to my evil twin).

� Email: JL0109@gmail.com


